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Traffic Procedures - Daily 

Introduction 

The daily traffic procedures are suggested ways of completing the data entry for programs, contracts, copy rotations, etc., 
as well as editing the schedules, assigning fillers and copy, etc.  Some steps may not be necessary according to how you 
do business.  You can tailor these instructions for your needs.  We do not recommend changing the order of things as you 
would not want to assign copy before checking if copy is missing, as well as before assigning fillers, because then you 
would have to do it a second or third time – once the missing copy has been entered and/or after the fillers have been 
assigned. 

Problem Statement 

To be able to reconcile and schedule spots, have the correct rotations, and send an electronic file to the automation 
system, certain procedures must be completed.  

Parameters 

Programming must be entered with avails for the spots to schedule into, contracts must be entered so that spots can be 
scheduled, copy must be entered so that rotation is accomplished, reports must be run to ensure accuracy, etc., etc. 

Solution Overview 

Reconcile the schedule for the previous day or weekend (required) 

Post the reconciled schedule(s) (required) 

Enter New Programs/Program changes (required) 

Enter New Contracts/Contract changes (required) 

Enter New Copy/Copy changes (required) 

Approve and Commit Contract schedule pages (required) 

Run the Contract Confirmations report (required) 

Reschedule Make goods (optional) 

Edit Schedules (required) 

Assign fillers (optional) 

Run the Missing Copy report (required) 

Assign Copy (required) 
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Run the Schedule Discrepancy report (required) 

Create Schedule file for automation (required if automated) 

Print logs (optional, required if not automated) 

Archive Database Tables (required) 

Create backup (required) 

Implementation: Step-by-step process to complete Traffic Procedures - Daily 

1. Reconcile the schedule for the previous day or weekend 

a. Use the Reconcile Logs function in the Automation module 
i. Go to the Traffic menu, choose the Automation module, go to the Actions menu, and choose 

Reconcile Logs 
ii. Set the dates to reconcile.  You can reconcile more than one day, but then the Exceptions report 

will be combined. 
iii. Set the channels to reconcile.  You can reconcile more than one channel, but then the Exceptions 

report will be combined. 
iv. Press the Start button 
v. When it is done, the Exceptions report will show on the screen 

b. Print the Exceptions report 
i. This is the only time you can get this report as it is.  Go to the top and select to print this report.  

We suggest using a PDF printer and saving the PDF.  Then you can print it to a printer if you 
want to 

ii. Once the report has been printed, you can close it 

c. Run the Verification Analysis report (optional) 
i. The Verification Analysis report is used to show percentages of dollars and spots that were 

schedules vs. what was verified 
ii. On the Automation module, go to the Reports menu, and choose the Verification Analysis report 
iii. Set the dates to the dates you just reconciled 
iv. Set the channels to the channels you just reconciled 
v. Press the Preview button 
vi. Check the percentages to be sure everything has high percentages.  If there are low percentage, 

there might be something wrong and you will need to do some research to find out what it is 
vii. You may save and/or print the report.  It is available if the data exists 

d. Run the Extra Verified Spots report (optional) 
i. The Extra Verified Spots report lists spots that ran that weren’t on the original schedule.  You can 

use this report to show certain Advertisers that you ran extra spots for them 
ii. On the Automation module, go to the Reports menu, and choose the Extra Verified Spots report 
iii. Set the dates to the dates you just reconciled – you can run it for one at a time 
iv. Set the channels to the channels you just reconciled – you can run it for one at a time 
v. Set the Advertiser 
vi. Set the Organize by to either Media ID or channel – if you just selected one channel, Media ID 

makes more sense 
vii. Press the Preview button 
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viii. You may save and/or print the report.  It is available if the data exists 

2. Enter New Programs/Program changes 
a. Follow the instructions on the White paper for entering programs for the type of programming you need to 

enter. 

3. Enter New Contracts/Contract changes 
a. Follow the instructions on the White paper for entering Contracts for the type of contracts you need to 

enter 

4. Enter New Copy/Copy changes 

a. Enter the Copy 
i. Go to the Traffic menu, choose the Traffic module, go to the Data Entry menu, and choose Copy 
ii. Click the Add button to add a new Copy record 
iii. Description:  Enter up to 30 characters to describe this Copy order.  The description is strictly a 

reference for all pages of the Copy order.  Enter all or some of the Advertiser name and the 
length.  You can use the Contract description too but be sure to enter the length here as well. 

iv. Order date: Leave as is. 
v. Advertiser:  Select the Advertiser  
vi. Account Executive: The A/E will autofill from the Advertiser record but you can change it here if 

necessary. 
vii. Rotation type: 

i. Even = the detail pages will rotate evenly 
ii. Percentage = the detail pages will rotate according to the percentage you set on each 

active page 
iii. Specified = the detail pages will rotate according to the pattern you set 

viii. Next in Rotation:  This number is used by the system.  You do not need to change it unless you 
want the rotation to start with a page other than the page listed (not common). 

ix. Variant:  This field is only available if Percent rotation is selected.  Leave it at number one. 
x. Rotation Position Page Numbers:  These fields are only available when Specified rotation is 

selected.  Enter the page numbers how you want them to rotate. 

xi. Enter the detail pages 
i. Press the Detail pages button 
ii. Click Add to add a new page 
iii. Regular button.  Make sure that this button is pressed when entering Copy for regular 

spots or the first part of a bookend set. 
iv. Valid from:  If not using Media Inventory, set this to the first date this media may be 

assigned to spots 
v. Valid thru:  If not using Media Inventory, set this to the last date this media may be 

assigned to spots 
vi. Schedule by:  These all may be left blank.  If not using Media Inventory, only fill in if the 

Traffic instructions are more restrictive than what is already on the Contract.  Example: 
The schedule pages of the contract can run between 6a-10p but the traffic instructions 
say to run this only between 10a and 2p.  Then you would enter the time.  You can also 
fill in the times so that it won’t assign to spots placed outside the ordered times. 

vii. Length: If not using Media Inventory, enter the length for this media.  Only enter zero if 
this is part of a bookend set.  If it is part of a bookend set, you will need to enter other 
media on a different Copy record.   

viii. % Rotn: Only set the percentage if you set the header to be a Percentage rotation.  This 
field is ignored for the other rotation types.  Enter the percent in relation to the other detail 
pages so that they all add up to 100%.  Example: 33.00 = 33%.  
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ix. Valid Run Days:  If not using Media Inventory, check which days this media can be 
assigned.  Match to the contract to prevent this media from assigning to spots scheduled 
outside the parameters of the Contract. 

x. Skip Weeks:  Only use this field if you need to skip weeks for this media.  Set to 1 to 
assign one week on and one week off.  Set to 2 to assign one week on and two weeks 
off. 

xi. Source: Only use this field if required by the automation system for this station 
xii. Product Separation:  Only use this field for an additional separation.  At the time of 

assigning copy, the system will look at any product codes on the detail pages and will not 
assign the media to other media with the same product code within the time parameters 
set for that product code. 

xiii. Media Inventory: If you use Media Inventory and the media already exists in the 
inventory, select it here and the other fields will fill in from the inventory record. 

xiv. Description:  If not using Media Inventory, enter the description for this media, up to 30 
characters.  Please be descriptive to help you find this media 

xv. Agency Description:  If not using Media Inventory, enter the ISCI code if you have one.  If 
not, use the same description as before 

xvi. Media ID: If not using the auto media numbering, enter the unique ID for this media.  If 
using the auto-ID numbering, enter the prefix, if necessary, and then press F3 for the 
next available number. 

xvii. Dual Spot button.  Make sure that this button is pressed when entering Copy for the 
second part of a bookend set. 

i. The Valid from, Valid thru, Schedule by, Length, % Rotn, Valid Run Days, Skip 
Weeks, Source, and Product Separation carries over from the Regular button.  
Do not change them. 

ii. Description:  If not using Media Inventory, enter the description for this media, up 
to 30 characters.  Please be descriptive to help you find this media 

iii. Agency Description:  If not using Media Inventory, enter the ISCI code if you 
have one.  If not, use the same description as before 

iv. Media ID: If not using the auto media numbering, enter the unique ID for this 
media.  If using the auto-ID numbering, enter the prefix, if necessary, and then 
press F3 for the next available number. 

xii. Add Script (optional) 
i. Go to the Script menu and choose either Add Script or Import Script 
ii. If importing a text file for the Script, choose Import Script 

i. Select the text file to import and click OK 
ii. Check the script to make sure it looks like how you want it to print 

iii. If not importing a text file for the script, choose Add Script 
i. Type the script how you want it to print and click OK 

iv. Repeat steps 2.b. – 3.c for each media needed to run 

xiii. Add to Contract 
i. Go to the Tools menu on the Copy data entry window and choose Add to Contract 
ii. Contract: Select the Contract from the drop-down menu by typing the Contract 

description 
iii. Add to Pages: Select All pages only if all media is the same length.  You must have a 

separate Copy records for each length.  If you need to specify the pages, separate them 
by commas.  Example: 1,2,4,7,10 

iv. Click the Start button  
v. Click the Close button when it is done. 
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b. Make Copy Changes 

i. Go to Copy Data Entry 
i. Go to the Copy Data entry and locate the copy record you need to change 

ii. Make the necessary changes 
i. Go to the detail pages 
ii. Set the thru date on any page that is no longer running 
iii. Add new pages for the copy that is going to start running 

iii. Add the Copy to the Contract(s) 
i. Go back to the Copy header and choose the Tools menu 
ii. Click on Add to Contract 
iii. Select the Contract and which pages to attach the Copy 
iv. Set the date to the valid data of the change 
v. Press he Start button 
vi. After it is done, it only takes a second, press the Close button 
vii. Repeat steps 1.a. – 3.f. for any Copy records that need to be changed. 

By using the Add to Contract Tool after making Copy changes, the spots on the schedules for the effective date and 
forward will have the Copy page reset to zero.  This is so when you Assign Copy to the schedules, the spots will then pick 
up the changes. 

5. Approve and Commit contract schedule pages 

a. Go to Contract Data Entry 
i. Select the Traffic module 
ii. Go to the Data Entry menu 
iii. Choose Contracts 

b. Click on the Approve button 
i. Go to the top right of the Contract 
ii. Click on the Approve button 

c. Select the schedule pages 
i. If you want to commit all schedule pages on hold, click the All button 
ii. If you want to commit individual schedule pages, click in the select box next to each line 
iii. You may also set certain restrictions to display only the pages you want 

d. Commit the schedule pages 
i. Click the Commit button 

Any pages still left in the list after committing are still on hold 

If you received any errors during the commit process, you can click on those page numbers to open the page 
and correct any necessary fields, then repeat the process to commit them 

6. Run the Contract Confirmations report 

a. Go to the Traffic Reports module 
i. Go to the Reports menu and choose the Traffic Reports module  
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ii. Select the tab for Contract Confirm 
iii. Make sure that the Use checkboxes are unchecked next to Include Order Dates and Include 

Revision date 
i. You may use these checkboxes but only to get all orders entered on a particular date or 

Revised on a particular date. 
iv. Select the Report format you want to use 
v. Make sure the correct boxes are checked under Exclude Comm to get net totals 
vi. Make sure no boxes are checked under Subtract from Gross 

i. You may use these checkboxes if you want to see how the order looks if there are make 
goods or canceled spots. 

vii. Make sure that all Restrictions are set to All except for Contracts 
viii. Click Include under Contracts and put a check next to the Contract you need 

b. Preview and/or Print the Report 
i. Once you have everything set correctly, press the Preview button. 

i. You can press the print button but please be sure you have everything selected correctly 

c. Once you are sure you have the information you need, you can press the Print button 

7. Reschedule Make goods 

a. Select the Channel(s) 
i. Go to the Traffic menu and choose the Reschedule make goods module 
ii. Select all Channels or include or exclude specific channels 

b. Select the dates of the make goods 
i. From: Select the start date of the make goods that are to be rescheduled 
ii. Thru: Select the end date of the make goods that are to be rescheduled 

c. Select the date onto which to reschedule the make goods 
i. From: Select the start date onto which to reschedule the selected make goods 
ii. Thru: Select the end date onto which to reschedule the selected make goods 

d. Select the Priorities 
i. Select all Priorities or set which priorities to include by selected the priority from and thru 

e. Select the Schedule type 
i. Select Full Schedule or Quick Schedule.  In most cases, you want to Full Schedule as that will 

move things around to get everything to fit, whereas Quick Schedule will only reschedule the 
make goods where there is room 

f. Click the Start button 
i. Make sure that everything is set how you want it 
ii. Click the Start button to start the reschedule 

i. This does not have a close button.  The cursor is usually in indicator that it is done.  It will 
not let you close it before it is done.  If you click the x in the upper right corner, it will only 
close when it is done 

8. Edit Schedules 

There isn’t really a systematic procedure for editing schedules.  You may use some functions more than you 
will use others.  The available options are outlined below: 
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a. Set distinct colors, text, and background for different elements 
i. Go to the Traffic menu, choose the Traffic module, go to the Schedules menu, choose Edit 

Schedules, go to the File menu, and choose Defaults 
ii. Click the Text button on any element to change the options for text.  You can change the font, 

style, size, effects, and color.  Be careful to select a distinct color from the background, or the text 
won’t be visible. 

iii. Click the Bkgd (background) button on any element to change the options for the background.  
You can change color and even make custom colors.  Be careful to select a distinct color from the 
text, or the text won’t be visible. 

b. Add a spot from Make goods 
i. When you open Edit Schedules, the Make goods window will automatically open as well. 
ii. Select a spot line in the make goods window, hold down the left mouse button, drag it to where 

you want it in Edit Schedules, and then release the mouse.  The spot will place after the line you 
drop it on.  If you want it to be first in the break, drop it on the break line. 

c. Remove a spot to Make goods 
i. Select a spot line, hold down the left mouse button, drag it to the make goods window, then 

release the mouse.  The system will automatically put it in the correct order. 

d. Change the Copy detail page assigned 
i. Select a spot line, right-click the mouse, and choose Change Copy 
ii. Enter the detail page you want to change to and press Enter or the OK button 

e. Change an avail/break 
i. Select an avail/break line, right-click the mouse, and choose Change Break 
ii. You can change the Run Time, Units, Length, Length Remaining, Units Remaining, and the Next 

Run Time 
iii. Change whatever you need, and then press the OK button.  You can only close this window if the 

Next Run Time is set correctly.  You cannot overlap the next break or any spots in the next break. 

f. Change programming 
i. Select a program line, right-click the mouse, and choose Change Program 
ii. We only recommend using this function when reconciling and only if you need the invoices to 

show the actual program in which the spots ran.     
iii. You can Change the length of the program and move the spots to make goods, Change the 

length of the program and keep the spots, or replace the program and move the spots to make 
goods.  There is a field for the New end time if you choose the change the length, and to put the 
new program name if you choose to replace the program 

g. Exchange spots 
i. Select the spot line of the first spot you want to exchange, then press and hold the CTRL key on 

the keyboard, then click the spot line of the second spot you want to exchange.  You can do this 
with spots in the same avail/break or different avails/breaks 

i. This only works either if there is room left in the avail/break or if the spots are the same 
length.  If the avail/break is full, and the spots have different lengths, you will not be able 
to exchange the spots.  

h. Open a Contract, Schedule page, Copy record, or Detail page 
i. Double click the item you want to open and that data entry form will open 
ii. If you make changes that affect the spot lines, you will need to click the Refresh button on the top 

right of Edit Schedules to reflect the changes 
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i. Change the reason on a make good 
i. Select a spot line in the make goods window, right-click the mouse, and choose Change Reason 

Missed 
ii. Select the option you need from the drop down and click the OK button 

j. Add extra fillers 
i. If you need to add more filler, use the Insert Spot from Contract function.  This only works on 

schedule pages with a priority between f and z 
ii. Place the cursor on the schedule where you want the extra filler to place 
iii. Go to the Edit menu, and choose Insert Spot from Contract 
iv. Enter the Contract you want to use 
v. Enter the schedule page number you want to use 
vi. The system will fill in the spot number if there are any available.  If not spot number, you will need 

to choose a different schedule page or a different contract 
vii. Once the spot number fills in, press the OK button and the spot will place on the schedule if the 

length is ok 

k. Cancel spots 
i. Select a spot line, right-click the mouse, and choose Cancel Selected Spot 
ii. This will take the spot off the schedule and will mark its status on the schedule page to 

“canceled”.  The system will also retime the break so another spot may be scheduled in its place 

l. Open New Edit Window 
i. Go to the Edit menu and choose Open New Edit Windows 
ii. This allows you to move spots between times, dates, and even channels. 
iii. You may have as many edit windows as the system memory will allow but they can only be 

opened from the main edit window 

m. Jump to Time 
i. Right-click anywhere on the schedule and choose Jump to Time 
ii. Enter the time you want to jump to – standard time or military time  
iii. Press Enter or the OK button 

n. Find a Contract 
i. Go to the Search Menu and choose either Find Contract (by Description) or Find Contract (by 

Number) 
ii. Enter the Description or Number depending on what you chose 
iii. Press enter or click the OK button 
iv. If you need to find the next spot from that contract, click on the line below where you are and 

repeat the above steps  

o. Find an Advertiser 
i. Go to the Search Menu and choose either Find Advertiser (by Description) or Find Advertiser (by 

Number) 
ii. Enter the Description or Number depending on what you chose 
iii. Press enter or click the OK button 
iv. If you need to find the next spot from that Advertiser, click on the line below where you are and 

repeat the above steps  

p. Find a Program 
i. Go to the Search Menu and choose either Find Program (by Description) or Find Program (by 

Number) 
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ii. Enter the Description or Number depending on what you chose 
iii. Press enter or click the OK button 

q. Find an avail/break 
i. Go to the Search Menu and choose either Find Break (by Description) or Find Break (by Number) 
ii. Enter the Description or Number depending on what you chose 
iii. Press enter or click the OK button 
iv. If you need to find another Break, click on the line below where you are and repeat the above 

steps  

r. Clear Breaks 
i. Go to the Tools menu and choose Clear Breaks 
ii. This function is more used for reconciling but can be used for last minute changes 
iii. Set the times to clear the breaks from and thru 
iv. You can choose to only close Empty breaks which can be used so that the breaks don’t fill with 

only fillers 
v. Then choose how you want to the system to deal with the spots in those closed breaks – you can 

Full Schedule them somewhere else, Quick Schedule them somewhere else, or directly move 
them to make goods 

vi. Once you have made your selections, press the Enter key or click on the OK button 
vii. You will see the breaks change to have to time remaining 
viii. If you later decide that you want to use that break, follow the steps for Change Break 

s. Display options 
i. Go to the Options menu and select how you want the lines displayed 

ii. In Edit Schedules, you can have just the Advertiser name on spots, the spots description, or both.  
For the breaks, you can have the program name, the break name, or both 

9. Assign Fillers 

a. Make sure Contract schedule pages have been entered for fillers 
i. Go to the Traffic menu and choose the Traffic module. 
ii. In the Traffic module, go to the Data entry menu and choose Contracts 
iii. Click the Add button to add a new Contract or locate an existing Contract. 

i. If adding a new Contract  
i. Enter the Product description as – the advertiser name, the term of the Contract.  

Example: Hay’s Market 3Q 2012 
ii. Tab to the Valid From date field and enter the date the Contract starts 
iii. Tab to the Valid Thru date field and enter the date the Contract ends 
iv. Tab to the Advertiser field and start typing the Advertiser name.  When it is 

highlighted in the list, press the enter key 
v. Press the tab key and the fields will fill in from the Advertiser record.  You may 

change any items necessary. 
vi. Tab to the Customer order number field and enter the Order number or P.O. 

number, if you have one.  If you don’t, you may leave this field blank 

ii. If adding to an existing Contract 

i. Enter the Schedule page(s) 
i. Click on the Schedule Pages button (towards the top right), to open the 

schedule pages 
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ii. Click the Add button 
iii. The dates will fill in with the dates from the Contract header but you can 

change them if necessary 
iv. Tab to the length field and enter the correct length for the spots 
v. Tab to the Pri field and fill in the priority for these spots – Valid priorities 

are between f-z for fillers 
vi. Tab to the Schedule by: fields and either enter runtimes or a Daypart or 

Program.  Enter the morning runtimes as 12a-11:59:59a, with a lower-
case a.  Enter Noon as 12n, with a lower-case n.  Enter the afternoon 
runtimes as 12:00:01p-11:59:59p, with a lower-case p.  Enter Midnight 
as 12m, with a lower-case m.  If the station’s broadcast day goes past 
midnight, enter those times with a lowercase x to keep them on the same 
day.  Example 6a Monday to 6a Tuesday would be entered as 6a-6x.  Do 
not use x times if the station’s broadcast day is Midnight to Midnight.  
That would be entered as 12a-12m. 

vii. Tab to the Schedule Qty: fields and enter the necessary quantities by 
day, week, or page.  The page option should only be used to enter many 
spots into a short span of days. 

1. For per day, enter the exact quantity to run per day. 
2. For per week, enter the quantity to run per day and then check 

the boxes for the days they can schedule 
3. For per page, enter the quantity to run per the dates on this page 

viii. Tab to the Copy field and enter the Copy record for this Contract.  If you 
have not entered the Copy record yet, you can skip this step 

ix. Tab to the Channel field and set it to the correct channel 
x. Click on the schedule tab to double-check the projected dates and times 

to make sure that is what you want 
ii. Repeat steps ii.  through x. for as many pages as you need to schedule 

b. Remove the Hold on the Schedule page(s) for fillers 
i. Go to the Tools menu and choose Remove Hold 

Repeat all steps necessary for any new filler pages you need to enter. 

c. Run Assign Fillers 
i. In Summit Traffic, go to the Traffic menu, Traffic module, and choose Assign Fillers 
ii. Set the dates to the dates you want to Assign Fillers 
iii. Set the channels to the channels you want to Assign Fillers 
iv. Press the Start button 

d. Check the Schedules 
i. In the Traffic module, go to the Schedules menu and choose Edit Schedules 
ii. Scroll through the schedule to be sure that the avails that you need to be full are full.  If they are 

not, you might need to add more fillers for various lengths to fill them up. 
iii. Once you have more fillers entered, go back to step 9.c. 

10. Run the Missing Copy report 

a. Go to the Traffic Reports module and click on the Missing Copy report tab 

i. Set the dates 
ii. Select the start date of spot run dates to include on the report 
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iii. Select the end date of spot run dates to include on the report 

b. Select a Report Format 
i. Use the dropdown to select the report format to use 

c. Set the Sort 
i. Right-click to select the sort options 

 
d. Set Report Options 

i. Show Report Selections: Select this option to have a page print before the report that gives a 
description of the report, the column headings, and the selections made.  

ii. Start Each A/E On New Page: Select to have each Account Exec.'s information to start on a new 
page.  The "Sort by" must have Account Exec as the first sort.  DO NOT USE with "Start Each 
Channel On New Page". 

iii. Start Each Channel on New Page: Select to have each Channel's information to start on a new 
page.  The "Sort by" must have Channel as the first sort.  DO NOT USE with "Start Each A/E On 
New Page". 

iv. Exclude Filler Spots:  Select to have any information for filler (priority f-z) spots excluded from the 
report. 

v. Exclude Canceled Contracts:  Select to have any information for spots on canceled Contracts 
excluded from the report. 

e. Set Restrictions 
i. Set "All" for all, or select which items to "Include" or "Exclude".  

f. Preview the Report 
i. We recommend previewing the report to ensure that you have the correct settings that you need.  

Just click the Preview button on the top right. 

g. Print the Report 
i. Once you are sure the report has the information you want, just click the print button on the top 

right and it will be sent to the default printer.  Also, from within the Preview window, you can set 
the printer settings to go to a different printer, print more than one copy, etc.  Then click the print 
button to send it to that printer. 

11. Assign Copy 

a. Make sure that the Copy data entry is complete 
i. Follow step 4 in this white paper 

b. Run Assign Copy 
i. In Summit Traffic, go to the Traffic menu, Traffic module, and choose Assign Copy 
ii. Set the dates to the dates you want to Assign Copy 
iii. Set the channels to the channels you want to Assign Copy 
iv. Press the Start button 

c. Check the Copy Unable to be Assigned report 
i. The Copy Unable to be Assigned report will automatically be generated when the system has 

finished assigning the copy 
ii. Check the report for any problems – problems can include totals not 100% on percentage 

rotations, length match issue, dates issues, etc. 
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d. Fix any problems and redo 
i. You need to go to the Copy data entry and fix any problems that have shown up on the report. 
ii. After you fix the problems, go back to step two. 

12. Run the Schedule Discrepancy report 

a. Go to the Report in the Traffic Reports module 
i. Go to the Traffic menu, choose the Traffic Reports module, click on the tab for the Schedule 

Discrepancy Report 

b. Set the dates 
i. Set the start date to the necessary date to start looking at information 
ii. Set the thru date to the necessary date to end looking at information 

c. Check or Uncheck Ignore Unassigned Copy  
i. If you are using the report to see any potential problems before printing the schedule or creating 

the schedule for automation, do not check this box. 
ii. If you are using the report to check things on the schedule before assigning copy, do check this 

box. 

d. Set the Report Format 
i. Set the report format to the one you want to use 

e. Set the Sort by 
i. Right-click in the Sort by field to select the sort option 
ii. You have up to three sub sorts as well 

f. Set the Report Options 
i. None of these are necessary to run the report.  Select whichever ones you want and be careful to 

match them to the sort.  You cannot select to Start each A/E and each Channel on a new page, 
only one. 

ii. If you are using the report to see any potential problems before printing the schedule or creating 
the schedule for automation, do not exclude Filler spots. 

iii. Exclude Canceled Contracts should never be used 

g. Set the restrictions 
i. If you are using the report to see any potential problems before printing the schedule or creating 

the schedule for automation, set all restrictions to all.  Otherwise, set which items you want to 
exclude or include, or set to all 

h. Preview and/or Print the report 
i. Click the Preview button to preview the report on screen.  It is recommended to preview before 

printing to be sure you have all the selections correct 
ii. Once in the Preview, you can select the print button to send the report to the printer.  You can 

also press the print button on the report form before previewing 

i. Fix any problems 
i. Fix any problems that come up and keep running the report until there are no more problems. 
ii. Some problems come up on the report that you can choose to ignore.  Outside the runtimes is 

one, but be careful that it isn’t too far outside the runtimes so that it will still reconcile 
iii. Keep running the report until all issues have been resolved 
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13. Create Schedule file for automation 

a. Go to the Traffic menu, choose the Automation module, go to the Actions menu, choose Create 
Schedule Files 

i. Set the channels to all, include, exclude, or Current - depending on what schedules you need to 
create 

ii. Set the dates to the dates you need to create schedules.  You can use any range of dates if the 
schedules are ready. 

iii. Click the start button 

b. Follow steps to send to automation, if necessary 
i. If your automation system set up requires you to do something with the files after they are created 

from within Summit Traffic, please follow those steps now. 

14. Archive database tables 

a. Make sure that everyone has Summit Traffic and all modules CLOSED 
i. Let everyone know that they MUST have Summit Traffic and all modules closed because you 

need to archive the data. 

NOTE: if something isn’t closed, one or more files will remain open and therefore will not archive 

b. Access the Utility module from outside Summit Traffic 
i. Go to Start>Programs>Summit Software>Utility 
ii. Logon like you do Summit Traffic 
iii. Select the button for Archive Database Tables 

c. Press the “All” button to select all tables 
i. Right below the list of files, click on the All button and make sure all files have a checkmark next 

to them 

d. Make sure the database path is correct 
i. Check below for the correct database path - the default is the drive where the data resides 

\Smt\Archive\Db 
ii. The filename will be Db plus the date in yymmdd format, with a .zip extension 
iii. You can browse to a different location, if desired 
iv. You can change the filename, if desired - do not change the extension 

e. Press the “Start” button to start the Archive process 
i. Be sure to click the Start button to start the Archive process 

i. Each file will uncheck as the file is being added to the zip 

f. Close everything 
i. Once the Archive is done, click the Close button to close the function 
ii. Close the Utility module 

g. Check the Archive to be sure all files are present 
i. Go to the path where you saved the zip and locate the one you just created 
ii. Open the zip file and make sure that all files are present.  You should have at least: advtiser.dta, 

customiz.dta, and zonegrp.dta. 
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h. Let everyone back into Summit Traffic 
i. Tell everyone that the archive is done and they can go back to what they were doing 

15. Create a backup 

a. Copy the zip of the Archive to some type of removable media or to the cloud, or both 
i. Go to where the archive is and copy it to removable media, such as a flash drive.  If you don’t 

want to have to carry the flash drive around with you, copy it to the cloud.  You can do both to be 
extra secure 

Frequently Asked Questions 

Question: Why am I getting a message saying that the logs have already been reconciled and do I want to remove 
the post flag and redo? 

Answer:  That message means that the date chosen for the channel chosen has already been posted.  The Reconcile 
Logs function automatically posts the logs after the reconcile process has finished.  If you run it a second time, you will get 
that message.  You will also get that message if someone manually posted the logs.  In most cases, it is ok to redo the 
reconcile but you should probably check with Summit Traffic support. 

Question: Why does the Exceptions report not have anything on it if I run the reconcile logs function more than 
once for the same date and/or channel? 

Answer:  That is because it usually isn’t putting spots in make goods because they were put there the first time it was run.  
It’s not going to report on something it did before. 

Question: Why do I have duplicate spots if I run the reconcile logs function more than once for the same date 
and/or channel? 

Answer:  That is an issue with the reconcile logs function.  It was not designed to be run more than once.  IF you are 
instructed to run it more than one, you will need to check the schedule for that date and channel to make sure there are 
no duplicates.  IF there are duplicates, then you will need to move them to make goods so they may be scheduled on 
another date. 

Question:  I checked Edit Schedules and the spots still have the old Copy on them, why? 

Answer:  This might be because step three was not done.  Do step three and check the spots again.   

This might be that you are looking at a date before the effective date that you used on the Add to Contract Tool.  The 
spots will only pick up the change for that date and forward.   

Question:  The rotation on the Copy was set to percentage and now they only want to run one spot.  The 
percentage spots are still running until the new spot takes effect.  What do I do now? 

Answer:  In this situation, keep rotation set to percentage and add two detail pages for the new spot, using 50 percent on 
each. 

Question: I have Traffic instructions for different lengths, how do I enter that and add them to the contract? 
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Answer:  You must use separate copy records and add them to the appropriate schedule page for the same length, with 
the Add to Contract Tool.  Do not check the box for All Page.  Enter the schedule page numbers, separated by a comma.  
Example: 1,2,4,7,10. 

Question: How do I know if the Copy has been added to the Contract schedule pages? 

Answer: The Missing Copy report would be best.  If everything is OK, it will be blank.  If there are problems, you will see 
information for the schedule pages in question, and the far right will give you the Copy record number and the reason for 
the problem, so that you can fix it before logs are even worked on. 

Question: What do I do when a spot is showing up on the Missing Copy report with an unknown reason, but it is 
attached to one page of the Contract? 

Answer:  If that Copy record should be attached to all pages, run the Add to Contract Tool again, making sure you select 
All Pages.  If that isn’t what the issue is, then try the steps below: 

1. Check to be sure that the Advertise on the Contract and the Copy are the same 
2. Check that the dates, etc. on the detail pages encompass the Contract 
3. Check that the lengths match between the schedule pages and the detail pages.  If you have different 

lengths, you must use separate Copy records and attach them to the correct schedule pages 
4. If you still have problems and can’t figure them out, contact Summit Traffic Support for help 

Question:  How do I make changes to a Copy record that has spots that have already run? 

Answer:  To stop using a detail page, set the end date to the last day it can be used.  To add a new cart #, just add a new 
page and fill it out according to the Traffic Instructions.  After you make any changes, use the Add to Contract Tool so that 
any spots assigned detail pages will be reset to detail page 0.  That way when you go to Assign Copy again, it will pick up 
the changes.  You may also refer to the white paper on making copy changes. 

Question: How often should I Approve and Commit the schedule pages to the schedules? 

Answer: We suggest that you check the Approve button a few times a day to be sure that all necessary spots are 
scheduled.  Make this a part of the daily procedures for finalizing a log. 

Question:  I’m getting no records found on the Contract Confirmation, why? 

Answer:  It could be that one of the checkboxes is checked under the Include Order dates and/or Include Revision dates.  
If one of those is selected and you don’t set the date to today, you won’t get a confirmation because the Contract you 
included won’t match the date selected.  That is why we suggest that you do not select those check boxes.  If you do set it 
to Include Order dates for today, and don’t select one Contract, you will get all contracts entered today.  The same goes 
for the Include Revision dates. 

Question:  I see at the bottom of the Confirmation that the Gross and Net dollars are the same but his Contact 
has an Agency commission.  How can I get it to show the correct Net dollars? 

Answer:  Make sure the box is checked to exclude the Agency commission from the total. 

Question:  I want to have different information on the Confirmations.  How do I change that? 
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Answer:  For now, it would be best to contact Summit Traffic Support to let them know what changes you would 
like.  They will let you know what they will need to make that happen. 

Question: Why didn’t all the make goods reschedule? 

Answer:  First you need to make sure that you included all the dates and channels for the make goods.  If so, it could be 
that the reason they went to make goods to begin with still exists.  The Reschedule Make goods module will not overwrite 
the scheduling rules. 

Question: Instead of right clicking a spot in the make good window to add it to the schedule, I used the Edit 
Menu, Add M/G to Schedule but it didn’t place the correct spot and not in the place I wanted it, why? 

Answer:  When using the Edit Menu, Add M/G to Schedule, you must click on the spot in the make goods window that you 
want to schedule, and the cursor must be set in Edit Schedules on the line that you want the spot to go after. 

Question: I want to place a spot on a different channel, is that OK? 

Answer:  Yes, you can place spots on different channels, dates, or times.  The system will give you a warning asking if 
you are sure.  If you answer yes, the spot will be placed – if there is room.  You might also get a warning about being 
outside the ordered runtimes or date, you can answer yes, and the spot will be placed – if there is room.  If you don’t want 
to schedule it on that channel, date, or time, then answer no. 

Question: I’m using Jump to Time but it is telling me it is invalid.  I entered 14:00 and clicked the OK button. 

Answer:  When using military time, you need to press the Enter key on the keyboard.  Also, you don’t have to enter the 
:00. 

Question:  The schedule page fields are grayed out and I can’t make any changes. 

Answer:  This is by design.  The system will not allow you to make certain changes when the page is not on hold.  If you 
must make a change to the dates, times, length, quantities, or channel, you will have to put the page back on hold, make 
the changes, click in the Agency description field, and commit the page again. 

Only put those pages on hold that start in the future.  If you come back later and need to make a change, you need cancel 
the page first.  Then you can add new or even copy and paste. 

Question:  I checked the schedule tab for the projected dates and times and they are not what I need.  What did I 
do wrong? 

Answer:  It is possible that your dates are not coinciding with the quantities selected.  This is most common when 
scheduling by week.  Keep in mind that Summit Traffic projects on a Standard Broadcast week (Mo-Su).  If the from date 
starts on a Sunday and you order five per week, you will get five spots on that Sunday.  To “fix” it, start the page on a 
Monday. 

The same holds true if the page ends on a Monday.  You will get five spots on that Monday.  To “fix” it, end the page on a 
Sunday. 

Question: I checked the schedule tab for the scheduled dates and times and there aren’t any.  Why not? 
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Answer: When you first enter a schedule page for fillers and remove the hold, the spots are not committed to the schedule 
yet.  They will be committed to the schedule when you run the Assign Fillers function, if there is room on the dates 
selected for the ordered times. 

Question: Can I manually place fillers on the schedule? 

Answer: Yes, but there must be an existing filler schedule page to do so.  See the White Paper for Insert Spot 
from Contract in Edit Schedules. 

Question: I ran Assign Fillers but there are no fillers on the schedule. 

Answer:  Make sure that you have some Contract schedule pages entered with a priority between f and z.  The priority 
does need to be entered in lower case.  Also, make sure that you remove the hold.  You do that by going to the Tools 
menu and choose Remove Hold.  Remove Hold will only show up if you use a filler priority between f and z. 

Question: I see that some fillers assigned but I still have a little room left over.  Is there a way to get fillers in 
there manually? 

Answer:  Yes, you can add fillers manually be putting the cursor on the schedule where you want it to go, and then go to 
the Edit menu and choose Insert Spot from Contract.  Choose the contract and schedule page and it will fill in the spot 
number.  Then press enter and the spot will be placed, if the length matches what is available. 

Question: When I click the Preview button, a blank page comes up.  Where is the Missing Copy report? 

Answer:  Look at the bottom left of the page and you will see the percentage of progress. 

Question: We have the A/Es follow up with the advertisers to make sure the media is in house before their spots 
are to run.  Do I have to run the Missing copy report more than once, including just one A/E at a time, so that I 
can hand them their accounts that are missing copy?   

Answer:  No, you can set the report to sort by A/E first, and then by Advertiser or even Agency and then Advertiser.  Then 
make sure that the Report Options are set to Start Each A/E On New Page. 

Question: I have a percentage rotation set on a Copy record and when I Assign Copy, the Copy Unable to be 
Assigned report keeps telling me that the percent doesn’t total 100.  I’m sure all the pages total 100%.  What do I 
do now? 

Answer:  The percentage is per the dates.  It is possible that the dates overlap or something like that.  Check that each 
date totals 100% and try the steps again.  If you still have problems, contact Summit Traffic Support for assistance. 

Question: Why does the Copy Unable to be Assigned report say there is an issue with the length? 

Answer:  Length issues are because the length on the Copy detail page it is trying to assign doesn’t match the length of 
the spots on the schedule.  You need to be sure that you have the correct copy attached to the schedule pages that 
matches the length. 

Question: I have a contract that is running two different lengths but only one length is getting copy assigned.  
Why? 
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Answer:  When you have a contract that has different lengths, you need to have a separate copy record for each 
length and they need to be attached to the schedule pages with the matching length.  That is the only way to 
ensure that the copy will assign correctly to each spot. 

Question: Can I still create schedules if I don’t run this report? 

Answer:  Yes, you can but certain problems could prevent you from creating the schedule file for automation, such as 
copy not assigned, etc. 

Question: What are some issues that it will list? 

Answer:  There are many.  Some are: Copy different – means that the copy on the schedule page doesn’t match what is 
on the spot, outside runtimes, outside ordered date, etc., etc.  If you aren’t sure what the discrepancy is, contact Summit 
Traffic Support for assistance. 

Question: I’m trying to create the schedule files but I keep getting a blank spot warning.  What do the numbers 
mean? 

Answer:  The first number is the Contract number, then the page number.  On = the channel number and date.  You can 
go into Edit Schedules and do a search for the contract number to find the spot.  You must fix it and create the schedule 
file again. 

Question: I keep getting a blank spot ID warning but I can’t find any missing copy on any spots.  How do I fix it? 

Answer:  That could be because a spot could be marked as a dual spot (bookend, piggyback, or tag) and the second half 
of the copy information is not filled out on the copy detail page.  Locate the spot in Edit schedules by doing a search for 
the contract number.  Double-click the schedule page number and check the dual spots tab.  If it is not a dual spot, go to 
the next one, and so on.  If it is a dual spot, in Edit Schedules, double-click the detail page number and add the dual spot 
info.  Then create the schedule file again. 

Question: I created the schedule file with no problems, no errors, but the file won’t load in the automation 
system.  When I look at it in Notepad, I see the same time on all spots.  How do I fix this? 

Answer:  It sounds like the ausched.dta file is corrupted.  Just replace that file in the \smt\db folder and create the 
schedule file again.  If you don’t have a blank copy of that file, contact Summit Traffic Support to send you one. 

Question:  What happens if I run an Archive more than once a day? 

Answer:  You can run an Archive more than once a day and the previous archive will be overwritten.  Our suggestion is to 
change the name of the zip file, so that you can have more than one in a day without them being overwritten.  Especially if 
you are once archiving for billing and then for the end of day. 

Question:  Can I have the archive output directly to a flash drive? 

Answer:  Yes, you can set the path for the archive to any drive, or path on the network or local computer.   

Question:  What do I do if some of the files are missing from the archive? 
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Answer:  You will need to make sure that every computer that has Summit Traffic installed has everything closed.  You 
can also use the Pervasive Monitor to see who still has files open.  Once everything is close, you will need to run the 
archive again. 

Question:  Can I have the archive output directly to a flash drive? 

Answer:  Yes, you can set the path for the archive to any drive, or path on the network or local computer.   

Question:  What do I do if some of the files are missing from the archive? 

Answer:  You will need to make sure that every computer that has Summit Traffic installed has everything closed.  You 
can also use the Pervasive Monitor to see who still has files open.  Once everything is close, you will need to run the 
archive again. 

Question:  What if I don’t take the flash drive with me and do not copy it to the cloud? 

Answer:  If you do not put the archive on some type of removable media or the cloud and you have a problem wherein the 
data needs to be restored, you might not be able to access it.  What if there is a fire in the office that destroys everything?  
If the data is on a computer in the office, it is lost.  If it was on a flash drive that was left in the office, it is lost.  If it is on a 
flash drive you have with you, or in the cloud, then it is not lost.  We can replace Summit Traffic and Pervasive, we cannot 
replace the data. 

Question: Isn’t an archive and a backup the same thing? 

Answer:  An archive is just a group of files in a compressed format that creates one file.  An archive can reside on a 
workstation, a server, in the cloud, just about anywhere.  For it to be considered a backup, it must be at some other 
location other than where the original data resides. 

Question: I don’t need to send a Contract Confirmation to the client.  Why is it marked required? 

Answer:  Even if you don’t send the Contract Confirmation to the client, it is a good idea to print it and attach it to the 
original order.  That way you can compare figures, etc. to be sure it has been entered correctly, and you will have a copy 
as to how it was originally entered, in case any issues come up later. 

Question:  Reschedule Make goods is set as optional, why?  Don’t I want to reschedule make goods always? 

Answer:  The Reschedule Make goods module is a fast way to get spots that could not schedule, or did not reconcile, 
onto the next day or day’s logs.  If you have the reschedule flag set to same date only, then this module won’t do you any 
good unless you are only looking at today’s make goods and trying to get them on today.  Keep in mind that if the reason 
the spots are in make goods still exists, they still won’t reschedule. 

Question:  I work for a cable company and have many channels.  Do I really need to Edit Schedules for each 
channel in each system? 

Answer:  It is good practice to check Edit schedules for each channel to be sure that everything looks like it should.  Like 
the program number on the break lines is the same as on the program lines, etc. 


